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Abstract  

The role of the teacher is very necessary to help students in the teaching and learning process so 

that the material can be understood optimally. A teacher is not only teaching in front of the class, 

but s/he must be able to inspire students. The process of implementing learning in Curriculum 

2013 requires teachers’ ability to posses IT, especially to make an easy, and interesting media 

because learning in the 2013 curriculum consists of observing, asking, and reasoning, trying and 

communicating. The assessment which is carried out in the 2013 curriculum includes three 

domains, namely affective, cognitive, and psychomotor. The purpose of this community service is 

to provide assistance in the development of power point slide learning media in the 2013 

curriculum learning on theme 1 about objects in the surrounding environment for fifth grade 

students of elementary school, Bogor Tengah. The main problem of schools in Central Bogor 

District is the limited facilities and facilities and infrastructure of the teaching and learning 

process; school limitations in the provision of innovative science and technology based on 

learning media; limitations of teachers who do not yet have competence in using effective 

teaching media; the learning process which must apply the 2013 curriculum with a scientific 

approach, this requires teachers to master IT in designing learning devices; the ability to master 

alternative innovative learning models that must be applied to the 2013 curriculum; teacher ability 

to prepare and use the IT-based learning media. The solution to the problem is to carry out 

training for the school teachers by providing theoretical material, the practice of making power 

point slides, up to evaluations through the evaluation of the drill practice method so that serious 

training in the implementation of the training can bring benefits to various parties.. 
 
Keywords: slide media; power point; elementary school students. 

________________________________________________________________________________________________ 

 

I. INTRODUCTION 

Learning is a process of teaching students. It is a 

process which has elements that are interconnected 

with one another. The relationship between one 

element and another will make learning becomes a 

whole unified. The  elements relate to the learning 

application among others are goals, the learning 

process which consists of teaching materials, methods, 

learning resources and learning media, evaluation of 

learning and learning actors, namely teachers and 

students. But sometimes the learning process often 

experiences problems or obstacles such as a changing 

curriculum. Changes in the curriculum are made 

intentionally with the aim of improving the quality of 

education. 

Active learning can occur with the help of 

media. But in reality the existing media is underutilized 

by the teacher. This is one of the factors that cause 

student boredom during learning. This condition is a 

continuing problem, because teachers lack innovation, 

especially in the procurement of learning media. 

The process of learning implementing in 

Curriculum 2013 requires the competency of a teacher 

to master IT comprehensively because starting from the 

making of learning tools in the 2013 curriculum is very 

closely related to the use of IT. Likewise with the use 

of instructional media teachers are required to create 

learning media that are not only non-projection-based 

media but are also highly demanded based on 

projections that are adjusted to the conditions of the 

globalization era that are conditions with technology. 

The process of approach to learning 2013 

Curriculum for Elementary School students is very 

complex and continuous, namely integrated thematic, 

theme-based learning, scientific approach known as 

basic learning experience: managing, gathering 

information, associating, and communicating. Likewise 

with the assessment carried out very broader than the 

the previous curriculum included three aspects of the 
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ability aspect, namely: affective, cognitive, and 

psychomotor. These are all efforts that aim to improve 

the quality of education in our country. Research 

conducted by Suryanto [1], about the Use of power 

points to increase activity and learning outcomes in 

social studies. The results of the study indicate an 

increase in learning outcomes with the use of these 

media. Another study conducted by Novita and 

Windiyani [2] on the Effect of using VCD multimedia 

on learning motivation in Democratic Community 

Culture subject. Based on the results of the research 

done, the use of media in the form of power point 

slides is deemed necessary to be developed in the 

application of the 2013 curriculum. 

Student inactivity results from a feeling of 

saturation in learning with a monotonous learning 

process and communication that is only done in one 

direction [3]. It was said so because the teacher only 

explained or only gave the task of filling out the 

student worksheet. As is known in the 2013 curriculum 

curriculum book the content of learning material tends 

to be small, can lead to student or even teacher's 

incomprehension. Teachers are still confused with the 

teaching material that can be considered lacking so that 

using media that has a goal to attract students' interest 

or motivation cannot be done. The teacher's lack of 

understanding of the 2013 curriculum and the lack of 

using instructional media can have an impact on the 

learning process. If these conditions occur, as a result 

students do not have the desire to learn, and then the 

quality of learning will decrease. 

The lack of students' interest in learning is 

inseparable from the teacher's role in using media when 

the learning process takes place. The interest of 

students in learning depends on the creativity of the 

teacher in utilizing the media that is adapted to the 

subject matter [4]. The way the teacher uses the media 

must be in accordance with the subject matter, and 

according to the learning method. This is because the 

media created is not necessarily suitable or in 

accordance with the material to be taught. In this case 

the teacher must be more creative in utilizing and 

developing existing learning media. 

Based on the analysis of the situation, namely 

conducting a visit to the location of the community 

service, the team observed and distributed the 

questionnaire to the Elementary School (SDN 2 

Pengadilan), the identified problem are: 

1.  The main problems of schools in the district of 

Bogor Tengah include: 

a.   Limitations of facilities and infrastructure of the 

learning process. 

b. School limitations in the provision of innovative 

science and technology based learning media. 

c.   Limitations of teachers who do not have 

competence in using effective learning media. 

2. Problems faced by teachers in elementary schools 

are: 

a. The learning process must apply the 2013 

curriculum with a scientific approach; this 

requires teachers to master IT in designing 

learning devices. 

b. Ability and mastery of alternative innovative 

learning models that must be applied to the 

2013 curriculum. 

c. The ability to master elementary school teachers 

in preparing and using IT-based learning media. 

The main problem of the school partners must 

be addressed immediately, based on the results of 

discussions with the principal of the Elementary School 

(SDN Pengadilan 2) and discussions with several 

teachers that were very important, including: 

1. One effort in resolving the limitations of facilities 

and infrastructure is by submitting a proposal to the 

mayor of Bogor to assist in the procurement of 

facilities and infrastructure needed by each school. 

2. One effort about the lack of teacher competence 

under the auspices of branch management. In 

applying 2013 curriculum learning-based with the 

scientific approach and learning models,  teacher 

associations of Bogor Sub district in Bogor together 

with the government and the team of Primary 

teacher education study program of Pakuan 

university held the training/workshops on making 

2013 ccurriculum learning devices and alternative 

innovative learning models. 

Based on the explanation above, it was agreed 

by the proposed team and partners that the main 

problems that were the priority that needed to be done 

were based on the assessment of the problem, so far the 

problem had not been resolved. Actually, from the 

various problem it was found that the absence of 

aassistance on the application of Learning Media Slide 

Power point on 2013 Curriculum for students of Bogor 

Tengah City Central Elementary School students 

becomes the problem. The solution of the problem is 

the effort to involve the proposing team that is the 

research and community service of Pakuan university. 

Determining the priority of problems to be 

resolved from the beginning was carried out by the 

Proponent Team, by disseminating the development of 

Slide power point learning media to several teachers 

and several students, carrying out an instrument test on 

Slide power point learning media and the result was 

getting a positive response from the teacher, head 

master, and from students [5]. From the results of 

preliminary observations followed by instrument 

testing in the field it can be concluded that the 

community service activities that the proposing team is 

expected to add to the development of interactive 

power point slide products so that the learning process 

can take place actively, creatively, effectively and 

pleasantly so that learning objectives can be conveyed 

well [6]. 
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II. METHODS 

The implementation of community service 

activities applies a method in two ways, namely the 

lecture method and the practice drill method for 

making power point slide learning media. The lecture 

method was carried out by means of the dedication 

team came to Elementary School (SDN Pengadilan 2) 

to disseminate the development training for making 

power point slide learning media. The lecture activity 

was carried out considering that many teachers have 

difficulties in delivering lesson material in their 

respective classes during the learning process. Based 

on Sudjana [7], the drill method is an activity to do the 

same thing, repeatedly in earnest with the aim of 

perfecting a skill to become permanent. 

The implementation of community service 

activities namely training applies the development of 

making interactive power point slide learning media 

through several procedures with the following stages: 

1. Preparation Phase 

Carrying the coordination by: 

a. formulating the training objectives to achieve. 

b. specifying specific skills 

c. determining the series of steps to be done 

2.  Implementation Phase 

a. Opening 

Expressing the goals that must be achieved after 

the training process is to complete the forms of 

training that will be carried out in making the 

development of making learning media. 

b. Implementation 

1) lecturing the instructor team conveyed 

theoretically about the importance of IT-

based learning media. 

2) reviewing the theme of the chase in the 2013 

curriculum 

3) starting opening an application or power 

point program, understanding the toolbar 

that is on the program. 

4) designing interactive power point slides 

according to existing themes, carried out in 

groups. 

5) making interactive power point slides 

according to the theme. 

6) ensuring that all participants are interested in 

participating in the development of 

interactive power point slide learning media 

development. 

7) giving the opportunity to participants to 

continue to practice repeatedly so that the 

process of making interactive power point 

slide media can be realized according to the 

initial goal. 

3.  End 

Motivating participants to continue to practice 

continuously so that the training provided can be 

more attached, skilled and familiar. 

 

4.  Closing 

Carrying out improvements in the form of 

reflections on learning in the classroom, and the use 

of media from used materials. 

 

 

III. RESULTS AND DISCUSSION 

Assistance in making interactive power point 

slide learning media was attended by 21 teachers from 

Sekolah Dasar Negeri Pengadilan 2 dan Pengadilan 5 

in Bogor City. The socialization activity was held at 

the end of December 2018. After initial observations 

were carried out, discussions were held with the 

principal as a partner, and the curriculum teacher 

appointed by the principal. The next stage is to 

determine the implementation of assistance in making 

interactive power point slide learning media, which are 

determined on Thursday, 11 January 2019. 

The implementation of mentoring activities 

made the interactive made the interactive power point 

slide learning media conducted on Thursday, January 

11, 2019 starting at 08.00 until 15.00 WIB. The 

mentoring activity of making interactive power point 

slide learning media aims to provide an understanding 

of the importance of using learning media so that 

teachers can create learning media by utilizing 

technology with applications or power point programs.  

The details of the activities are 

1. Presentation of material with the lecture method on 

the importance of using learning media in 

motivating and improving student learning 

outcomes. The use of this learning media prioritizes 

the use of technology in accordance with the times. 

Explanation of this material in the form of 

introduction to the power point program, toolbars 

that exist in the power point program, convenience 

obtained from the use of interactive power point 

slide learning media. After that, explanations of the 

ways to make power point slides that attract 

students to learn, by including elements of animated 

videos and images. 

2. Division of work groups 

The teachers are divided into several groups (each 

group consists of 2 people) and guided by a team of 

lecturers and students. 

3. Practice making interactive power point slide 

learning media [8]. 

a. Prepare the tools and materials needed in 

making interactive power point slides. (Laptops, 

curriculum, teacher books and student books). 

b. Study and discuss teaching materials or material 

to be made into interactive power point slides, 

according to the theme. 

c. Determine the design that matches the theme 

and characteristics of the student. 
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d. Choose a theme; in power point there are 

default themes that can be selected. Start using 

existing themes. 

e. The selection of themes is tailored to the design, 

color, and letters. Then click the Design tab >> 

click the down arrow in the Themes column >> 

select the theme to use. In this exercise we use 

Slate. To change the color combination, still on 

the Design tab >> in the Variants column select 

the color combination you want to use. To 

change the letter combination, still on the 

Design tab >> in the Variants column, click the 

bottom arrow. A new area will appear 

containing several choices. Click Fonts >> 

select the letter you want to use. In this exercise 

we chose Arial Black-Arial. 

f. Using the diagram, the trick, click the Insert tab 

>> click Chart, In the Chart window that opens, 

click Pie >> then the right side select the donut-

shaped chart, then click Ok. After that, it's time 

to change the value of the chart so that it is 

divided into four equals. Just fill in each value 

so 1. Delete the information because it only 

needs the chart. 

g. Enter a picture or photo, how, click the Insert 

tab >> click Pictures, in the new window that 

opens, find and select the photo that is suitable 

for use. Click the photo >> click Insert 

h. Enter animation or video, how to do it, click 

Animations >> click Animation Pane, to add 

animation, click the text or image. Then, still in 

the Animation tab >> select Fly In. Click Effect 

Option >> select From Left, the image will enter 

from the left. Start set On Click. 

This assistance received a positive response as 

evidenced by the enthusiasm of the teacher in 

participating from beginning to completion. They also 

carry laptops and teaching materials or materials for 

making interactive power point slide learning media 

[9]. The readiness of the teachers indicates that there is 

a motivation for better learning. When giving material 

about the introduction of this power point program, 

they learned a lot, because it turns out there are still 

teachers who do not understand the parts in the 

toolbars, the functions of the toolbars and it can be said 

that they do not fully understand this program. During 

this time they taught using only media still images, 

even if they were required to make power point slides, 

they asked for help from others. That condition makes 

the teachers happily receive when given training in 

making this power point slide learning media. Teachers 

realize that technological advances require them to 

continue to innovate in learning. This innovation can 

be done by making media adapted to technological 

developments. The use of interactive power point slide 

learning media will of course be able to foster students' 

motivation and interest in learning, so that learning 

outcomes are expected to be achieved. That is why 

teachers in this era are required to be creative and 

innovative, so as to produce students / students who are 

suitable for educational purposes. At the end of the 

mentoring of making this interactive power point slide, 

the teachers divided into several groups presented the 

results of the learning media that had been made. This 

proves that they are serious in taking part in mentoring. 

Data on community service results are taken 

based on questionnaires that have been distributed to 

elementary school (SDN Pengadilan 2 and 5) in Bogor 

City. Data about the respondent's characteristics can be 

found in the table below: 

Table 1 Respondent Characteristic 

Description   Total 

Distributed questionnaires   21 

Returned questionnaires   21 

Unreturned questionnaires     0 

Damaged/incomplete 

quetiionaires 

    0 

P|rocessed questionnaires   21 

 

Based on the table above the total number of 

questionnaires representing a population is 21 

respondents. 

 

Table 2  Respondent Respons Characteristics toward an 

Assistance of Making power point Interactive 

Learning Media Slide 

 
No Variabel Yes No Total 

1 Media usage in teaching learning 

activity in the classs 

2 19 21 

2 Benefits of using learning media 
(interactive powerpoint slides) to 

increase student motivation and 

learning outcomes 

21 0 21 

3 

 

 
 

The importance of using learning 

media (interactive powerpoint 

slides) to increase motivation and 
learning outcomes 

18 

 

 
 

3 

 

21 

 

4 Facilities in schools need to be 

added, so that teachers can use 

ICT-based learning media 

(interactive powerpoint slides) 

21 0 21 

5 

 

 

Mentoring activities carried out 

by lecturers at FKIP Unpak 

provide influence and benefits in 
making ICT-based learning 

media (Interactive power point 

slide) 

21 

 

 
 

  

0 

 

 
 

  

21 

 

 
 

  

6 Mentoring activities 
Still want to continue mentoring 

about ICT-based learning media 

(interactive) power point slides 

19 12 2 

7 Mentoring activities 

Still want to continue mentoring 

about ICT-based learning media 
(interactive power point slides) 

21 0 21 

 

Table 2 shows that as many as 19 respondents 

gave responses related to the use of learning media. A 

total of 19 respondents did not use learning media. This 
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means that there are still many teachers who have not 

understood the importance of using learning media. 

Only 2 respondents have used ICT-based learning 

media (power point slides). Then in the second 

statement about the benefits of using ICT-based 

learning media (interactive power point slides) 21 

respondents agreed that the use of learning media, 

especially ICT-based learning media (interactive power 

point slides) can increase student motivation and 

learning outcomes. The use of learning media 

(interactive power point slides) in its development can 

foster students' interest in learning, learning becomes 

more fun, active, creative and meaningful. Then in the 

statement about the importance of using learning media 

(interactive power point slides) to increase motivation 

and learning outcomes answered by 21 respondents. 

This means that respondents agree that the use of 

learning media is important in building students' 

understanding, which basically thinks from the 

concrete rather than from abstract. Students need to be 

given an understanding of real material rather than 

abstract ones. Then as many as 20 respondents 

answered agreeing to add learning facilities. 

This means that ICT-based learning media 

should be facilitated by the school. Facilities such as 

LCDs, laptops and tools that are related to ICT learning 

media need to be added. 21 respondents agreed on the 

implementation of this mentoring because it provides 

influence and benefits in making ICT-based learning 

media (interactive power point slides). But for the sixth 

statement from 21 respondents, who agreed to the 

continuation of this assistance, only 19 respondents and 

the remaining 2 people did not agree. Then the last 21 

respondents agreed that they would still like to 

collaborate with FKP Unpak in assisting the making of 

ICT-based learning media (interactive power point 

slides). 

 

 

 

 

 

 

 

 

 

 

Figure 1. Teacher's response towards picture before 

and after being given assistance 

 

Referring to Figure 1, it can be seen that as 

many as 19 of the 21 respondents stated that they never 

use learning media either projection or non-projection. 

This means that teachers have not fully understood the 

importance of using learning media. They still provide 

lessons only with conventional methods and media. 21 

respondents understood the benefits of using projected 

and non-projected learning media. They understand the 

benefits of using instructional media, especially the 

power point slide learning media that can help students 

understand concrete stages. In the sense to make 

elementary school students understand a teaching 

material must be accompanied by concrete 

explanations. Then regarding the importance of the use 

of learning media, it was agreed to by 18 respondents 

and 3 respondents answered disagree. The answer is 

no, it can be understood because the facilities that 

support the use of media are still lacking. This shows 

that the school needs to provide facilities that support 

the success of learning. The effort made by the teacher 

is less successful, due to the lack of support from the 

school or the local government. In terms of the use of 

ICT-based media, facilities such as computers, laptops, 

LCDs and internet-related facilities are needed. 21 

respondents were hoping for further training, so that 

they would be more maximal in providing learning. 

 

IV. CONCLUSION 

Based on the results of the mentoring activities 

in making interactive power point slide learning media 

in SDN Pengadilan 2 in Bogor City, it can be 

concluded that the teachers need mentoring training 

related to learning media. This is based on the 

importance of using learning media adapted to 

technological developments. The need for mentoring 

was proven by the antismism of the mentoring 

participants who followed from the beginning to the 

end and they made slides with themes that were 

adapted to the teaching material in the class they were 

teaching. The teachers are aware of the need for 

innovation and creativity in learning which will later 

provide increased motivation and learning outcomes to 

students. 

 

Suggestion 

Referring to the conclusion above, it is 

necessary to suggest the following: 

1. There is a need for further assistance related to the 

creation of learning media that are tailored to the 

needs of students and technological developments. 

2. There should be more additional facilities in the 

form of infrastructure related to the use of 

technology-based media, such as Laptops, LCDs 

and Wi-Fi 
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